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October Meeting Info


…. Mike Murray


Date:  Saturday October 25, 2008


Time:  First Pickup at 7:00AM


Location: Paul Pierce Facility in Louisville


Phone:  (513) 724-7777


Directions:  See information inside newsletter. This is a bus trip with three (3) pickup points. Williamsburg, Hampton Inn East and Florence Mall.





Food: Lunch is provided at Paul’s.





Return: Approximate departure from Louisville 3:00PM








Website Information


Queen City Chapter Web Site: � HYPERLINK "http://www.ncrs.org/qc/" ��http://www.ncrs.org/qc/�


Webmaster:   Jack Hunt   � HYPERLINK "mailto:jmhunt826@yahoo.com" ��jmhunt826@yahoo.com�





SWAP MEET  PLANNING MTG.


…. Bruce Slattery & Steve Hack





As many folks as can make it… please come to our Annual Swap Meet planning meeting on Tuesday evening (6:30PM) October 21, 2008. All are welcome.





Each year we have had a great event… but we would like to make it better. YOUR input is really important. What can we do better? What can we add? What have you heard as feedback?





If you can’t make it personally please give us a call and share your thoughts:





Bruce: 513-741-0848  Steve: 513-553-2080





GET PUBLISHED…SHOW-OFF


….. The Editor


Send in a technical article, want-ad, or interest story about your hobby. We also want to start a member spotlight section…who wants to be first? Next newsletter deadline is November 6th. E-mail your items to:


� HYPERLINK "mailto:rrussell@trgbrandinnovation.com" ��rrussell@trgbrandinnovation.com�





LOUISVILLE VISIT TO PAUL PIERCE FACILITY


….. MIKE MURRAY	


We only have 54 seats so let me know ASAP if you want to go… since this trip is open to friends and family you best get your reservation in early. Cost is $20 per seat which includes lunch at Paul’s place. For those ladies going to Oxmoor Center on Shelbyville Road… sorry… lunch there is at your own expense. Beverages will be served on the bus… both ways.


Some of you have already paid.. don’t worry I know who you are. However, some of you signed an intent sheet at the past few meetings… you will have to call me and reconfirm… ASAP.  The only guaranteed seats are those already paid for.


Here is what is happening:


Saturday 10/25/08  Croswell Bus


7:00AM Depart  Williamsburg


7:15AM Arrive Hampton Inn Eastgate


7:30AM Depart Hampton Inn Eastgate


8:15AM Arrive Florence Mall Main Entrance Exit 181


8:30AM On the road to Louisville


As we arrive: 


Drop-off at Oxmoor Center for interested parties.


Continue to Paul Pierce’s place


Lunch at Paul’s… included in your $20.00


3:00PM (Approx.) Depart for Cincinnati


Pickup at Oxmoor Center


Mike Murray 513-724-7777














 

















Humor & Other Useless Stuff


…… Anonymous


DID YOU EVER WONDER?


Can you cry under water?


How important a person has to be before they are considered assassinated instead of just murdered?


Since bread is square, why is sandwich meat round?


If a deaf person has to go to court, is it still called a hearing?


DID YOU KNOW?


No piece of paper can be folded in half more than seven times.


Donkeys kill more people annually than plane crashes.


Women blink nearly twice as much as men.


All polar bears are left handed.











Back lights, left directional dim no flashing, no right directional at all or too dim to notice. With the car running I have four brake lights, left directional ok, right directional ok, but dim. With car running and headlights on I have no back lights at all. Left directional dim, no flashing, right directional no lights, no flashing, or too dim to notice. What in the world has happened????


Also, when the door ajar light is on and the directional signal is applied, the door ajar light flashes along with the directional indicator in the dash cluster! HELP!!!


Re: 68 Gas Gauge/Tail Lights acting wacky


…… Bob Cook Sunday, 20 July 2003, at 3:32p.m.


Check the dash ground!


Re: 68 Gas Gauge/Tail Lights acting wacky


…… Don Izzo Sunday, 20 July 2003, at 4:20 p.m.


A wise man once told me most problems with Corvette electrics is almost always the ground! In this case he was right. I found the ground wire for the tail lights at the rear of the chassis had broken away from the terminal end and reattached and all is now well with the 68!! Just one note … I couldn’t believe how many different systems functions were affected by this ground. If you would have told me so I would have said you were nuts!!!


Want to Sound Intelligent?


…… Dave Schwoeppe


There are a lot of ways to appear intelligent, but the one I like to use myself is to know facts that other people might never learn in their every world. For example:


Men can read smaller print than women can; women can hear better.


Intelligent people have more zinc and copper in their hair.


The youngest pope was 11 years old.


If a statue in the park of a person on a horse has both front legs in the air, the person died in battle. If the horse has one front leg in the air the person died as a result of wounds received in battle. If the horse has all four legs on the ground, the person died of natural causes.


Honey is the only food that doesn’t spoil.


Father’s Day: There are more collect calls on this day than any other day of the year.














Pictures: Jim Dumont’s Event


…… The Guy With The Camera


Unfortunately the guy with the camera did not make Jim’s meeting. If he had we would have genuine proof of the girlie calendar rumors.





Membership News


We have two more members to add to our roster this month:


Eed Higgins		1967


Jim Kelly		1967, 1969, & 1982


Best, Matt


Membership in the Queen City Chapter of the NCRS is open to all members of the NCRS National Organization. Dues are $20 per year. For membership information, please contact any of the chapter officers listed on the left side of this page.





Kings Island Meet: Pictures


…… Newsletter Staff


Page 5.


Picture #1: We all know these four fellows, but please notice that Kurt Meier does not have a beer and Bill Hengstebeck is drinking a Sprite.


Picture #2: Marilyn Heitzman is a delight to work with. She smiled the whole day.


Picture #3: Ken Johnson posed for pictures all day, Phil Schott (under the hood) did most of the judging.


Picture #4: Matt Stansbury tried to find a shady spot, but the sun moved.


Picture #5: Otto Tackas was amazed that someone can both have a nice car AND drive it also.


Picture #6: Paul Oslansky wasn’t doing anything at the moment, but said the Master Judge was really tough and he had to look busy.


Picture #7: Kurt Meier has this really nice 1954 Corvette. He said this car drove to the show on its own … so we are not really sure if this is actually his car.


Picture #8: Scott Smith has returned. We know he was judging this car, but the guy with him was taking pictures. We guess Dave and Marilyn have started something new … Documented Judging.


Page 6:


Picture #1: We had a great turnout, this is just a few of the solid axle cars.


Picture #2: We didn’t know what was going on when we saw all these people around this car, so we took a look. See picture #3.


Picture #3: It was Dave Schwoeppe looking at himself in the driver’s side mirror. We were told he was like that for at least a half hour.


Picture #4: Jerry Hilbert, we found out, was just standing around looking like he was a judge. He actually signed some autographs for a few of the out-of-town judges who admired his professional demeanor.  


Picture #5: There were even more Corvettes in the parking lot.


Picture #6: This is Rod Russell’s 1976 Corvette. It only runs a few weeks out of each year.


Humor & Other Useless Stuff


…… Anonymous or Embarrassed


Some mistakes are too much fun to only make once.


The AMA & NZMA have declared that the long-term implications of drugs or medical procedures must be more fully considered. Over the past few years, more money has been spent on breast implants and Viagra than is spent on Alzheimer’s Disease research. It is now projected that by the year 2015 there will be fifty million people wandering around with huge breasts and erections who can’t remember what to do with them.





 walk up straight staircases.


A HEALTHY HEART


Compared to the British and Americans:


The Japanese eat little fat and suffer fewer heart attacks.


The Japanese drink little red wine and suffer fewer attacks.


The Italians drink excessively and also suffer fewer attacks.


Conclusion: Eat and drink what you like. It’s speaking English that kills you!


BET YOUR FRIENDS DON’T KNOW THIS:


Turtles can breathe through their butts.


























Have you ever been to a “body drop”? It is helpful to have a few friends available. Bob Dransman invited a few of us to his garage to help him drop his restored 1964 Corvette convertible body onto his restored 1964 Corvette frame. Including Bob, there were twelve eager participants, they were: Dave Klotter, Ron Miller, Matt Stansbury, Bob Burkhardt, Gary Congers, Tom Huellemeier, Richard Parsons, Steve McKay, Tom Marley, and Rod Russell.


Bob purchased his 1964 Red Corvette Convertible in 1984, shortly after he met Bob Burkhardt. This was Bob Dransman’s first Corvette. 


Bob had gone to visit Bob Burkhardt’s garage and was impressed with his personal collection of old cars and asked if he would help him find a mid-year Corvette. Three weeks later Burkhardt had a lead and they went to see the car in a Rink’s parking lot in Fairfield Ohio. It was a red 1964 convertible, black interior, with both tops, a 300 hp engine, 4 speed, and original knock-off wheels. 


Bob didn’t make an offer right away, and when he decided to go-for-it, he found the price wanted was higher than his budget. However, Bob has a secret weapon when it comes to negotiations… he calls her Anna Dransman.  She is good, really good, she negotiated and they got the car at their price. Bob says she might be available to help you also, but she will negotiate a fee.. be ready! 


The 1964 was driven daily to work for over ten years. The restoration actually began because Bob wanted to rebuild the engine.  He then joined the QCNCRS and the body soon came off.  All of this rebuilding started in late 1993. The body actually came off in 1994.


Bob does all his own work, including painting the body and the frame, plus rebuilding the engine. 


The body was dropped back onto the frame on Saturday, December 4, 1999. Bob was a very good sport and only had his eyes covered for short periods of time.


It was discovered that Matt Stansbury has a 1963 which needs its body removed… so we all volunteered to spend the afternoon helping Matt.  After all… it would complete our training. Don’t know why, but Matt said he would have to work his nerve up to let us come to his shop to help.





he plans to remove the body fromIt was well done To keep these instructions, choose Print from the File menu. Press Enter to print the template. Replace the sample text with your own text to create your newsletter.


Using Styles in This Template


To change the Style of any paragraph, select the text by positioning your cursor anywhere in the paragraph. Select a Style from the drop-down Style list at the top-left of your screen. Press Enter to accept your choice.


�


See Page 4 to learn how to edit or replace this picture.


The styles available in this template allow you to change the look of your headlines and other text. The following is a list of some common styles and their uses.


Body Text - Use this style for the regular text of an article.


Byline - Use this style for the name of the author of an article.


Byline Company - Use this style to type the author’s company.


Sidebar Head - Use this style to type a second-level heading in a sidebar article.


Sidebar Subhead - Use this style to type a third-level heading in a sidebar article.


Sidebar Text - Use this style to type the text in a sidebar article.


Sidebar Title - Use this style to type first-level headings in a sidebar article.


Footer - Use this style to type the repeating text at the very bottom of each page.


Heading1 - Use this style to create headlines for each article.


Heading2 - Use this style to create section headings in an article.


Jump To and Jump From - Use these styles to indicate that an article continues on another page.


Mailing Address - Use this style in a mailing label to type the destination address.


Postage - Use this style in a mailing label to type postage information.


Return Address - Use this style in a mailing label to type your address.


Picture Caption - Use this style to type a description of a picture or illustration.


Subtitle - Use this style to type sub-headings in an article.


Use PullQuote to excerpt text from the main text of a story to draw a reader’s attention to the page. See page 4 for an example.


�





Chairman’s Message


……  Steve Hack 





Well, September is behind us.  What a busy month for Queen City activities.  Our Chapter Meet at Montgomery Chevrolet on the 13th was a huge success with 11 cars judged, several sportsman cars, great food, and great people.  The event was held indoors as rain was threatening to ruin the day.  Montgomery Chevrolet has been a great location for our meet rain or shine.  Our monthly meeting was delayed one week due to a power outage at the Hilbert's.  Our annual picnic was held at Fernbank Park on the 28th with over 60 members, family, and friends.  It was a beautiful day and a great idea to have fried chicken as opposed to four cooks slaving over hot grills for the day.  Save the date for September 27th 2009, as we voted at the picnic to continue using the park for next year's picnic.


 


Saturday October 25th will be our next meeting in Louisville at Paul Pierce's shop.  We are taking a Croswell Bus Trip for the low cost of $20 per person, including lunch.  We took this trip a few years back and it was a huge success and great time for all that attended.  This year the ladies are invited as they will take a detour and visit some local shopping spots while the guys are drooling over Paul's cars. 





BUS TRIP TIMELINE   3 pickup points:


�7:00AM  Bus leaves Croswell Bus Station in Williamsburg


7:30AM  Bus leaves Hampton Inn in Eastgate on SR32


8:30AM  Bus leaves Florence (Exit 181 turn rt at RT18 go 100' turn rt into Value City, KMart go to end of parking lot)


 


If you would like to join us for this fun filled day or if you need further information call Mike Murray (513-724-7777) or Steve (513-553-2080).  The ladies can give Mary Carolyn Eyl a call (513-896-9563).  Remember we only have 54 seats so reserve your spots now!!!


 


Our November Meeting at Columbia Chevrolet will return to Tuesday on November 18th.





Our annual Christmas Dinner will be Sunday the 7th of December.  The Site for this year is still being investigated.  More details in the works.


 


See you all on the trip Down South...





Upcoming QCNCRS Events


	


Oct  16-18  Knoxville  Corvette Expo.





Oct  25th  Paul Pierce’s Garage Louisville, KY





SEPTEMBER MEETING: 


……  Otto Takacs, Jr.





Our September QCNCRS Meeting was held on September 16, and was hosted by Jerry and Barb Hilbert at their home. Jerry has a great garage with a lot of nice cars that make it an ideal place to hold one of our meetings. A lot of our members drove Corvettes to the meeting that night so along with Jerry's cars there were a lot of nice Corvettes to see. As usual, the food was great and was enjoyed by all the members. Special thanks to Jerry and Barb for having us over and all that they did to make a great evening.





Steve started the meeting by thanking Jerry and Barb and welcoming the members.   A new member was also welcomed : Von Swink, who has a '57 Corvette.





Steve talked about our Chapter Meet and thanked all the members who had cars at the Meet and the members that helped judge cars. Steve especially  thanked Gary Griever and all of his people at Columbia Chevrolet for hosting the Chapter Meet at their facility.





After evaluating the meet, the club has decided to address a couple of the items on our registration form and some of the policies pertaining to the format of the meet. We will be talking more about these things in upcoming meetings.





Steve also talked about our annual Christmas Dinner this year which will be held on December 7, at  Receptions. The time will be 4:30 to 8:30 p.m.  Steve will have more information on this at our next meeting and on our web site. 





Mike Murray gave our Treasurer's Report and it was approved by all of our members.   Mike went over all of the financial matters of the Chapter Meet with the conclusion that the club did well this year.





John Ballard is Chairman of the Regional Meet we are sponsoring in 2010.   He gave an update of the event and answered any questions that members had. John also said that he would like to run for Regional Rep of our region when elections are held next year.





Dave Schwoeppe went over a letter that we get from the National around this time every year in which  they  ask Chapters in our Region if they would like to host a Regional Meet in 2011.  Dave will have more on this at our next meeting.  If you have any questions you can call him at 513-661-5019.





Our October QCNCRS Meeting will be on Saturday October 25.   We will be going to Paul Pierce's Garage to see his cars and have a Judging session.  We will be renting a bus for the trip and it will cost $20.00 per person.   We need to know as soon as possible if you are planning to attend.   You can call Steve Hack at 513-553-2080 or Mike Murray at 513-724-7777.


                                       Secretary,


                            Otto G. Takacs Jr. 









































































































































































































































 


    























































































































A good time was had by all. As always there was a lot of food… and as always… there was none left.

















     Our July QCNCRS meeting was held on July 20 and was hosted by Paul and  Leslie Oslansky at their home. It was a great evening and a Paul and Leslie did a wonderful job with the meal. Special thanks to the both of them.





       Kurt started our meeting by talking about two nice events that our club has had this summer so far. Kurt thanked Dana Banfield and his wife and Greg Steinmetz for a great road tour and Mike and Olivette Murray for our annual steak cookout. A lot of effort and work went into these events by these members and it was greatly appreciated by everyone.





      Kurt went over some of the details for the upcoming chapter meet at King's Island in September. All facilities and accommodations are taken care of with the people at King's Island and we will be going over all of the positions that need to be filled to put on the meet at our next meeting. Volunteers are needed for a variety of things so please let Kurt know if you are  able to help.





    The planning and work that has been done on the  Regional Meet that we are having next year is going very well. We have some very nice pledges from the following companies so far. They include Eastern Corvettes,  Keen Parts, Trim Parts,  Eagle Products and Auto Zone. We have more sponsors that we are currently talking with and all members are encouraged to help with getting additional sponsors. If you would like to help with contacting possible sponsors or know someone who would like to be a sponsor you can contact Jim Dumont and talk with him. His phone number is .513-761-9593.





    Bob Burkhart gave our treasurer's report and everything is fine. Bob would like all members who are coming to the Chapter Meet to register as soon as possible and you can do this at our meetings or call Bob at 513-777-5952. He also has hats and T-shirts for sale and is talking to members to see if there is enough interest in getting new club shirts.





    Jim Dumont is checking the signs that we use at our Chapter Meet . If any signs need to be repaired or new ones made and you would like to help with this please talk to Jim at one of our meetings.





    Matt Stansbury gave our membership report and we are doing great. We have around 150 members so far and people still joining. Matt gave an update on what is going on at the Corvette Museum and things that we can help with. For members who would rather read the Side Draft on the web site and not want a hard copy mailed to them. please let Matt know and he will take care of everything for you.





    Steve Hack and Phil Schott will be doing the tech session on Friday evening September 24 at our Chapter Meet. Not only are they members of our club but they have achieved a very nice goal: they are both Bloomington Gold Senior Work Shop Instructors.  We are very happy for them for their accomplishments and glad to have them in our club.





   The guest speaker at our July  meeting, Dave Lombardo, does photo memories. Dave will take a picture of your car or you can send one to him and he will print it on something that you would like, such as a shirt, coffee mug, or maybe a mouse pad. Dave's company is Photo Memories, 16541 S. Broadway, P.O. Box 235, Moores Hill Indiana. His phone number is 812-744-1129.





          Our August meeting will be on August 17, and will be held at Jim Dumont's home. Jim's address is 226 Worthington Avenue, Cincinnati, Oh. If you need directions, Jim's phone number is 513-761-9593.


                                       Secretary,


                                  Otto G. Takacs Jr.�











Shouldn’t Have Said That!


…… Dave Schwoeppe





I liked the last newsletter that had a few funny things that people have said when their mouth got open before the thought about what they were saying. But


Then there are children. A few days ago I was in line at the bank where I do business and was standing behind a lady with a little 3 year old girl who was jumping all over the place.





She finally grabbed the toddler after receiving looks of disgust and annoyance from a lot of the other folks also in line. Very clearly I heard the women tell the little girl, “If you do not start behaving right now I will have to punish you.”





The little tyke stamped her foot, looked her mother in the eye and said very loudly, “If you do not let me go right now, I will tell Grandma that I saw you kissing Daddy’s pee-pee last night.”





The silence was immediate. I never saw a women move so fast in my life. The bank was filled with laughter well after I left.





How Smart Are You?


…… Bill Hengstebeck





You may not believe this, but I fish with a lot of very intelligent people. Just to prove my point… see if you can get a few of these questions correct: Which of the following are true or false?





Apples, not caffeine, are more efficient at waking you up in the morning.





People do not get sick from cold weather, it’s from being indoors a lot more.





Alfred Hitchcock did not have a bellybutton.





A pack-a-day smoker will lose approximately 2 teeth every ten years.





Seven per cent of the population are lefties.





40 people are sent to the hospital for dog bites every minute.





40,000 Americans are injured by toilets each year.





The first Harley Davidson motorcycle built in 1903 used a tomato can for a carburetor.





A coat hanger is 44 inches long when straightened.





Babies are born without knee caps. They do not appear until they are 2-6 years old.





Sooo… how well do you think you did? My fishermen buddies got 10 right. Did you?  Be honest. The answer is on the next page:
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Update from Dana Banfield...    Details are coming together for the first 


annual Q. C. Chapter Spring Road Tour. Time to take off those winter covers , 


fill up those ' vettes with Sunoco 260 , and head south .The date is set for 


Saturday June  5th  2004. The route will take us thru some great scenic back 


roads in central Kentucky.  The destination .... Gayla Driving Center in 


Georgetown , KY.    Gayla is a Carriage Horse  farm , managed by me and my wife Debbi .


                                                                          re-elected as treasurer for our chapter. 





Our fall Chapter Meet will be held on September 18, 2004 at King's Island. We are starting to make plans for the meet and will have more details in the upcoming months.





Our web site is up and running and you can visit it at ncrs.org/qc. Jim Kammerer, Jack Hunt and Dana Banfield will be taking care of the web site for our chapter.


 


We have a new form available for our members to fill out at our meetings. It is to update our files for phone numbers and e-mail addresses. Be sure to fill one out as soon as possible. Also, Dave Schwoeppe made a new Survey and Profile questionaire for all members to fill out. The survey will address the concerns members have and any suggestions for improving things we do at our chapter.





Kurt filled out our annual chapter report and sent all information to the national NCRS. We accomplished everything required by the national NCRS board and received the Chapter of the Year award. John Adamson is in charge of this project for our chapter. If you have any questions you can talk to him at our meetings.





Paul  Oslansky has worked with Roy Sinor and we now have a poster showing the number of judging points each member has. Paul will bring the poster to our meetings and will keep it updated. If you do not see all your points, ask Paul.





Matt Stansbury is collecting membership dues for 2004. They are $ 20.00 and you can pay Matt at the meetings or send the money to his home. Matt's address is 3675 Rackacres Drive, Cincinnati,Ohio 45211.





Bob Burkhart gave the Treasurer's report and everything is fine. Our chapter made a donation to the Shriner's Burns Hospital this year and Bob also has t-shirts and hats for sale.





Carl Plummer is taking orders for jackets and also has Lusso Wax products for sale. You can talk to him at the meetings or call him. His home phone number is 513-563-5547.





Paul Oslansky's wife is a special education teacher and she would like to have any of your gently used or new car posters that you do not need. Leslie uses them to reward her students and they are greatly appreciated. You can bring them to the meetings and give them to Paul. However, Jim Dumont would like any of your old Snap-On Calendars.





 John Ballard is going to have a judging session for our chapter on Saturday April 17, at Classic Restoration in Louisville,Ky. Mike Murray is checking on possibly arranging a bus for all of us to ride down to Louisville. We will have more information at our next meeting.





Our March meeting will be a joint meeting with the Fort Thomas Corvette Club on March 9, 2004 at Tom Gill Chevrolet in Florence KY.  Mike Murray suggested that we change our June cook-out meeting to a Sunday afternoon instead of Tuesday evening and that wives/guests be invited.  The date is still pending.





Our February meeting will be on February 17,at Trim Parts.Inc. They are located at 2175 Deerfield Road, Lebanon,Ohio. The time will be 7;00. Their phone number is 513-934-0815





Secretary,


 Otto G. Takacs Jr. 





Special Notices:


…… Matt Stansbury





QCNCRS dues ($20.00) are due January 1, 2004. As always I am interested that everyone gets them to me as early in January as you can. You can either see me at any of our upcoming meetings or send them to me at:


Matt Stansbury


3675 Rackacres Drive


Cincinnati, OH 45211





International Marketing


…… Dave Schwoeppe


I have a few friends who work in International business and they were telling me some really interesting stories about what some companies have done to themselves because 


they


I always thought sign language was just for people with hearing problems, but my normal hearing neighbors have moved it into genuine entertainment.  I am still laughing.


Alan, age 10: LOVE AND MARRIAGE


You got to find someone who likes the same stuff. Like, if you like sports, she should like it that you like sports, and she should keep the chips and dip coming.


Lynnette, age 8: WHAT DO MOST PEOPLE DO ON A DATE?


Dates are for having fun, and people should use them to get to know each other. Even boys have something to say if you listen long enough.


Kevin, age 8: HOW WOULD THE WORLD BE DIFFERENT IF PEOPLE DIDN’T GET MARRIED?


There sure would be a lot of kids to explain, wouldn’t there? 


Pam, age 7: WHEN IS IT OKAY TO KISS SOMEONE?


When they are rich.


Kids listen to the adults around them and they reflect what they hear … it just comes out a little different.


onhis is the first time I have written a story for our newsletter, so I hope what I have to tell will make you laugh the same as it did me.


I don’t know how many of you know of my past affiliation with the Air Force, but it gave me many interesting stories about people… children especially.  Here is one that still makes me laugh, all though I heard it years ago. 


It was late at night and Heidi, who was expecting her second child, was home alone with her 3 year old daughter, Katelyn. When Heidi started to go into labor she called 911.


Due to a power outage at the time, only one paramedic responded to the call. The house was very, very dark, so the paramedic asked Katelyn to hold a flashlight high over her mommy so he could see while he helped deliver the baby. Very diligently, Katelyn did as she was asked. Heidi pushed and pushed, and after a little while, Connor was born.


The paramedic lifted him by his feet, and spanked him on the bottom. Connor began to cry. The paramedic then thanked Katelyn for her help and asked the wide-eyed 3-year-old Katelyn what she thought about what she had just witnessed.


Katelyn quickly responded, “He shouldn’t have crawled in there in the first place. Spank him again!”








 “Oh,” replied the wife. “Well, did you offer the man anything to drink?”


“Umm, no, I didn’t,” said the farmer. The wife then said, “I’m going to take something out there for him to drink.” The wife went to the cellar, got a bottle of wine, and then went out to the barn.


She didn’t return for over an hour, and when she did, her clothes were also messed-up, and she had straw twisted into her blond hair. She went straight up the stairs and into bed.





  





The January meeting will be at The Car Barn instead of  Montgomery Inn Convention Center. The meeting will also be moved to the 4th Tuesday, January 25th.  We thought the $2,000.00 Montgomery Inn wanted to host our event was WAY TOO MUCH!


November Meeting Minutes


……  Allen Braga


Host:  Jeff Barnhardt at Restoration Station


Tim Mickey, Chapter Chairman, opened the meeting at 7:55 PM.


Tim held an election of officers for 2000 and 2001. The following positions were up for re-election with all candidates “running” unopposed. Needless to say, these are the people who were elected:


Secretary:   Allen Braga


Membership Chairman:  Matt Stansbury


Judging Chairpersons:  Dave & Marilyn Heitzman


Road Tour Chairman:  Dan McDonough


Tim reminded everyone that dues for 2000 are due by next month.


Matt Stansbury talked about what he has in mind as Membership Chairman.


Publish the new Membership Directory in January. That is why he would like everyone to have his/her dues in on time.


Have special QCNCRS decals created.


QCNCRS business cards with membership information on the back. We can give these to anyone with interest in joining the chapter.


QCNCRS referral incentive of $10.00 dues rebate for new member referral (limit two rebates per member!)


Tim then discussed the following:


2000 QCNCRS Chapter Meet:


The Harley Dealer being built at Kings Island doesn’t look like it will interfere with our Chapter Meet.


He signed an agreement with K.I. for 2000.


Items to purchase:


A number of possibilities were discussed and people were asked for additional suggestions.


It was decided to table any decisions to  until January.


It was also decided to include a ballot on this subject in a future newsletter.


Tim received a letter from the NCRS Financial Director, Ken James, requesting a financial report be sent for this year’s Regional Meet. Tim and Bob Burkhardt will finalize the results and send them.


Bob Burkhardt:  Treasurer’s Report


Beginning Balance:		$8016.75


Receipts:			$  61.00


Expenditures:		$ 700.50


Ending Balance:		$7377.25


Bob reported our Regional Meet had cleared $4603.26 to-date with $500.00 still to be sent to Shriner’s Burns Institute.








includehaeach referralPossibleThis document was created using linked text boxes, which allow articles to flow continuously across pages. For example, this article continues on page two, while the one to the right continues on page three. When you add lines of words to a text box, the words in the following text box flows forward. When you delete lines of words from a text box, the words in the next text box moves backward. You can link several text boxes in an article, and you can have multiple articles in a document. The links do not have to occur in a forward direction.


Inserting Linked Text Boxes


To insert linked text boxes in a document, click Text Box on the Insert menu. Click and drag in your document where you want to insert the first text box, and insert additional text boxes where you want the text to flow.


To select the first text box, move the pointer over the border of the text box until the pointer becomes a four-headed arrow and then click the border. Click the right mouse button, click Create Text Box Link and then click in the text box where you want the text to flow. Repeat these steps to create links to additional text boxes.


In the first text box, type text that you want. As the text box fills, the text will flow into the other text boxes that you’ve linked. To let the reader know that an article will continue on another page, insert a small text box under the text box, choose the Jump To style, and then type the words “Continued on Page.” Click Cross-reference on the Insert menu. Choose Heading from the Reference type drop-down list, and Page Number from the Insert Reference To. Select the name of the follow-up heading from the For Which Heading list box and then click Insert.


Formatting Text Boxes


You can change the look of linked text boxes by using color, shading, borders, and other formatting. Select the text box you want to format and then double click its border to open the Format Text Box dialog box. If you want to change the color or borders on a text box, choose the Colors and Lines tab. To change the size, scale, or rotation, click the Size tab. To change the position of the text box on the page, click the Position Tab.  If you have other text surrounding the text box, and want to change the way the text wraps around it, click the Wrapping tab. If you want to format all the text boxes in an article, you must format them individually - the formatting on one text box will not apply to the others in the sequence. 


Using Linked Text for Parallel Articles


You can use linked text boxes to flow text in parallel  “columns” from page to page. This method gives different results than using the Column command on the Format menu, which causes text in column 1 to flow or “snake” to column 2 on the same page. By using linked text boxes, you can instead have text from column 1 flow to column 1 on the next page. The text beside it in column 2 can flow to column 2 on the next page, parallel to column 1. This technique is useful if you need to group two similar articles, for instance, an article translated in English on the left and the same article translated in French on the right. 


To flow text in parallel, display paragraph marks in your document. Click at the top of the page where you want the side-by-side columns to start, and press Enter twice. Click in the first paragraph mark on the page. On the Insert menu, click Text Box and drag on the page where you want the first column. Click Text Box again and then click and drag where you want the second column. Click in the last paragraph mark on the page, and press Ctrl + Enter to create a page break.


Repeat the process for each page that will contain side-by-side columns in your document and then return to the first text box you created. Click the text box on the left once to select it. Click your right mouse button and then click Create Text Box Link. The pointer becomes a pitcher. Click the text box on the left side of the second page to create a link. Create links for all text boxes within the same article on the left side of the document. Repeat the process for every text box in the right chain or article.


Pressing Enter twice at the top of each page will create an extra empty paragraph. This blank paragraph is useful if you want to insert text or graphics outside of the text boxes. You can delete the extra blank paragraph if you don't need it.


Copying linked text boxes


You can copy an article or a chain of text boxes that are linked together, to another document or to another location in the same document. To copy linked text boxes and the text they contain, you must copy all the linked text boxes in an article. Select the first text box in an article. Hold down Shift, and click each additional text boxes you want to copy. On the Edit menu, click Copy. Click where you want to copy the text boxes and then click Paste.


To copy some of the text from  an article, select the text you want to copy from the article and then copy it. Do not select the text box. You can paste text you’ve copied directly into your document, into another location within the same article, or into another article.(



















































































CHRISTMAS PARTY


�Our annual Christmas Party will be Sunday December 7th from 4:30-8:30 at Receptions on Loveland Madeira Rd.  Please reserve your spot now by calling Paul Oslansky at 513-965-8009.  The cost is $30 per person with a cash bar available.  Deadline for reservations is November 29th.  





Louisville Trip Saturday 10/25


…… Mary Carol Eyl


Hi Girls, have we got a deal for you – the bus taking the guys to the aforementioned garage will also be taking us to a mall so we can have a fun day out in a  different city, too.  If you’d like to participate, let me know at either   JoeEyl@aol.com   or 513) 896-9563 ASAP so can let Mike Murray know how many seats we’ll fill. Please call or e-me and I’ll put you on the shopping list.  There will only be one bus so let me know ASAP. 














25th and the cost for the bus ride is $20/person.  The bus will pick-up people at the Eastgate Mall by the Hampton Inn and at the main entrance of the Florence Mall.  Now you say your significant other isn’t going but you’d still like to do the mall in Louisville?  It’s not etched in stone that they go, so come on and have a fun time without them…





Thanks,


MaryCarol Eyl











































































































        


 6.2 D The Vice President shall automatically be appointed to the position of President when the position is vacated by the sitting President for the remainder of the previous president’s term. 








5.6 REVISED





Any vacancy in Officers, Managers, or Editors shall be filled by appointment by the President for the remainder of the term, with the exception in the vacancy in the office of the President which will be automatically filled by the Vice President, as stated in 6.2d.  This appointment to the office of President shall be for the remainder of the current term.  Any person appointed must be an active member.








The NCRS Foundation Mission statement was adopted:





Formed in 2006, the NCRS Foundation is a 501(c)(3) Charity designed to provide individuals and/or corporate sponsors an avenue to make charitable contributions of monies, stock/securities and/or Corvette archive memorabilia to support the NCRS Charity program. 





In addition the Foundation 2007 Milestone and Target Dates were announced.          





The next board meeting will be held in Marlborough, MA, on Friday, July 27, 2007, following the National Convention.


 


If you have any questions about the Board Meeting, please contact me.  


 


Keep on Vett'n!!


 


Marilyn Heitzman


Region II Director


�
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Staight-axle and mid-year cars have no circuit protection in the main power feed (main ignition wiring harness) from the starter to the rest of the car. A short circuit could result in a fried wiring harness and maybe a fire. To avoid this, remove the main wire from the starter terminal (don’t forget to disconnect the battery), cut off the end and install a GM fusible link which comes with a terminal connector on one end. The fusible link should be sized two numbers larger than the existing feed wire. For example, if the feed circuit is 14 gauge, a 16 gauge fusible link should be installed. This will insure that the fusible link fries before the wiring circuit does. Another  tip for straight- axle cars is to install a 1-amp fuse in the clock feed to avoid frying the rewind coil. If the battery gets low, there may be enough power to close the clock points, but not enough to open them, which results in the coil heating up and burning out.





The next morning at sunrise, the man in the barn got up and continued on his journey, waving to the farmer as he left the farm and walked toward the mountain. A while later, the daughter woke up and came rushing downstairs. She went right out to the barn, only to find it empty. She went to her father and said, “Where’s the man from the barn?”


Father answered, “He left several minutes ago.”


“What?”, she cried. “He left without saying good-bye? After all we had together? I mean, last night he made such passionate love to me.”


“What?”, shouted the father. The farmer ran into the yard looking for the man, but by now the man was halfway up the side of the mountain. The farmer screamed up at him, “I’m gonna get you! You had sex with my daughter.”


The man looked back down from the mountainside, cupped his hands next to his mouth, and yelled out ………….


ILAIDTHEOLDLADEETOO..  And that’s the true origin of yodeling … honest.




















Free GM Restoration Packet


… Reprinted from Northern CA NCRS 


For merely the asking, GM will send you a restoration package for your Corvette or Chevrolet vehicle.. FREE! When you call, request a restoration package for your model year vehicle. Be prepared to give them your Corvette’s (Chevy) serial number as well as the model.


Ask for a “Restoration Package” (it’s free in the USA). The restoration package they send includes complete engineering specifications for your year model, and also a very long list of parts vendors.


The USA Restoration Pack will NOT give you specific information for your individual vehicle, but generic info for the





Season’s greetings from your newly elected Membership Chairman. I want to remind everyone who have not sent in their $20.00 dues to please send them to me ASAP. I’m going to make-up the directory and have it ready for January 2000. I announced at the Nov. meeting that any current member who signs-up a new member gets $10..00 off his/her membership dues (two maximum). Remember the new Sportsman Class and invite a friend who might think their car doesn’t fit in with our group. This is an excellent program to get more people and Corvettes involved. If you have any questions or ideas concerning membership please contact me at: 513-662-1886. Have a Safe & Happy Holiday!


Best,  Matt


Humor and Other Useless Information


……  No One We Know!


A FEW USELESS FACTS


A duck’s quack doesn’t echo, and no one knows why.


Camel’s milk does not curdle.


In every episode of Seinfeld there is a Superman somewhere.


Cat’s urine glows under a black light.


MORE TEXAS BUMPER STICKERS


The early bird may get the worm, but the second mouse gets the cheese.


Jesus loves you… everyone else thinks you are an asshole.


Keep honking, I’m reloading.


Cover me, I’m changing lanes.


If you smoke after sex, you are doing it too fast!
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		  New Richmond, OH 45157-8661


		  steve@easterncorvettes.com 





V. Chairman:     Dave Schwoeppe (513)661-5019


		  3729 Boomer Road


		  Cincinnati, OH 45247-8017


		  aplusinc@fuse.net


Judging:	  John Ballard (502) 426-2184


		 10102 Kimblewick Drive


		  Louisville, KY 40223-2184


		  john.ballard@burgesspigment.com


Secretary:	  Otto Takacs, Jr. (937)294-2179


		  4331 Overland Trail


		  Dayton, OH 45429-1835


		  genevagear@sbcglobal.net


Treasurer:	  Mike Murray


		  777 East Main Street


		  Williamsburg, OH 45176-1442


		  bowtie@fuse.net


Membership:	  Mike Croake (513) 683-2734


		  734 Oskamp Drive


		  Loveland, OH 45140


		  mfcroakesr@hotmail.com


Historian:	  Don Budke, Jr.


		  1524 Teakwood Avenue


		  Cincinnati, OH 45224-2157


		  Buds42277@aol.com


Editor:		  Rod Russell


		  7742 Twelve Oaks Drive


		  Cincinnati, OH 45255


		   � HYPERLINK "mailto:rrrussell@fuse.net" ��rrrussell@fuse.net�
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